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Learning Outcomes: 
 
In this class you will: 

 Become familiar with the Windows 10 operating system 
 Improve mouse & keyboard skills while you practice using common  

Windows 10 features:  
o File Explorer  
o Desktop 
o Taskbar 
o Applications 
o Windows 

 Work on challenges to apply your new skills 
 Review additional resources to help you learn more 

 
Quick Quiz: 
Draw a line to match the correct symbol with its Windows function: 

  Close - closes the program’s or file’s window completely 

  Maximize - opens the window up full screen  

  Minimize - hides the window from view (it is still accessible from your task bar) 

  Restore - restores the window to a previously specified size 
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Quiz answers: 
 

 Close - closes the program’s or file’s window completely 

 Maximize - opens the window up full screen  

 Minimize - hides the window from view (it is still accessible from your task bar) 

 Restore - restores the window to a previously specified size 

 
Windows 10 – Operating System 
 
Today we will be looking at the Windows operating system. We will look at the main elements of 
the operating system, how to find and open software, and how files are made and organized. 

Let’s start with a short video from GCF Learn: 

Computer Basics: Understanding operating systems (1:30) 

https://edu.gcfglobal.org/en/computerbasics/understanding-operating-systems/1/  

 
As the video reminds us, computers use code as their language. To make that code 
understandable we need software that allows us to interact with the computer. The most 
essential type of software is the operating system. 

This software can be different depending on the device or type of computer you are using. In 
the library, we use Windows 10. For the sake of security, some features are disabled. 
  

https://edu.gcfglobal.org/en/computerbasics/understanding-operating-systems/1/
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Exercise 1: Tour the Desktop 
 
Windows uses the concept of an office. In your office you might have a desk (on the computer 
you have your workspace, or Desktop), a filing cabinet (on a computer that is your hard drive 
organized into folders containing files and viewed through File Explorer) and a Recycle Bin 
(where deleted files go). 

 
The Desktop 

 
 
TIP: At TPL, Volume Control for your headphones is available through a shortcut on the desktop 
and on the taskbar. On a home computer, the volume control is next to the Clock. 

  

Start 
Menu 

Desktop 

Window 

Taskbar File 
Explorer 

Clock and  
Multilingual keyboard 
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If we look at the TPL desktop we see a lot of icons. These are desktop shortcuts. Here at the 
library we use these shortcuts to make it easy for you to find and open the software you want 
to use. You can tell it’s a shortcut because of the little arrow on the lower left corner of the icon. 
At home you can create your own for frequently used programs! 

    
 
What’s different at the Library? At home your Windows desktop (on a PC or on a laptop) may 
look slightly different, but the basic principles are the same. You can access all of your software 
through the Start Menu and you can add shortcuts to your desktop if you want to. 

 
 
TIP – Library Recycle Bin: Another difference at the library is if you delete a file on a TPL 
computer, it is permanently deleted. At home you can undelete files from the Recycle Bin. 
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Taskbar Tour: 
You have a lot of control right from the taskbar. In the lower right corner, you will find a clock 
and access to keyboards in a variety of languages. Take a look: 

  

In the lower left corner there is the Start Menu Button, File Explorer (to see all your files), 
quick access to popular software (you can customize this at home), plus an icon for each open 
application.  

Notice: The Taskbar gives you some visual cues: in this example, Edge is not open but Chrome 
is open. File Explorer is open and active - can you spot the difference?  
Yes – Icons for Open software are underlined and Active software has a light box around it. 
 

 

  

Multilingual 
keyboard access 

Clock 

Multilingual 
keyboard 
details 

Start Menu 
Button 

File Explorer 
(Open and active) 

Edge 
(not open) 

Chrome 
(Open) 

Word 
(Open) 
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Exercise 2: Opening Software Applications 
One of the simplest ways to access your software is to use the Start Menu. 
 
Method 1 – Scroll full list: 

1. Click on the Window icon (or Start Menu) in the lower left corner of the Taskbar 
2. You will see an alphabetical list of your software and Windows tools, plus tiles of the 

most popular applications 
3. Scroll down the menu, choose an item, and click once to open 

 
Method 2 – Browse the Alphabet: 

4. You can also browse the alphabet by clicking on the # or & symbol, then clicking on the 
first letter of your item. For example: W for Word. 
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Method #3 – Search: 
5. You can also Search 
6. Depending on your system, you may see a search box or a magnifying glass 
7. Click to start typing, then  
8. Click on your result 
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Method #4 – Desktop Shortcuts: 
9. If you have shortcuts on your desktop, or your taskbar, you may also choose to open 

software using these handy shortcuts.  
10. For example, you can double clicking on the Chrome desktop shortcut or single-click 

on a Taskbar shortcut 

   
 

Using whichever method you prefer, let’s try opening and closing some windows. 
 

1. Start by opening Chrome. 
2. Notice: there is now a white box around the Chrome icon in the taskbar at the bottom 

of your screen. This indicates the application is open 
3. Also notice the size and position of your Chrome window. Does it fill the screen? Can 

you see the desktop behind it?  
4. Click on the X in the top right corner to close Chrome and see the desktop.  
5. Try opening other application, such as the File Explorer. 
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Tour: Parts of a Window 
 
Open Chrome if you do not already have it open. Some key common parts of a window 
include: 

 

 

These are very common features in most windows. Here is another example, File Explorer: 

 

Edges for 
resizing 

Scroll bar 

“Title” Bar Min/Max/Close 

 

Edges for 
resizing 

Min/Max/Close Title Bar 
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Exercise 3: Resizing and Moving Windows 
Let’s experiment with re-sizing our Chrome window. A useful technique is to use the buttons in 
the upper right corner of your window to Minimize, Maximize/Restore or Close a window. 

 

  

 
 

1. Click on maximize (the middle button). What happens? 
2. Notice how the (middle) maximize button looks different now? This is Restore. 
3. Click on Restore. What happens?  

 
Note: this button is a “toggle” so it changes as your window changes, toggling between two 
states. If you click Maximize, the window fills the screen and the button changes to Restore. 
Click Restore and you will have a smaller sized window and the button changes to Maximize.  

Try it out several times to get used to it! 

4. Click on Minimize. What happens? 
5. Click on the Chrome icon in the taskbar. What happens? 
6. Click on the close button. What happens? 

 
  

Maximize Close Minimize Restore Close Minimize 
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Resizing using the edges of a window 
 
Let’s open Chrome again using a different method. 
There are 2 methods: use the desktop shortcut, or the taskbar shortcut. 

1. This time click once on the Chrome icon in the taskbar 
 
Q: Why did we only have to click once this time but if we used the desktop shortcut we had 
to double click? 
A: Icons in the taskbar are for “pre-loaded” software and ready to open with a single click!  
 

 
 
2. Hover your mouse pointer over the right edge to get a two-headed arrow, then click, 

hold and drag the edge left or right to resize the window. 
3. Try the same thing with the lower edge or the corner. 
4. Practice until it is comfortable. 
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Moving a Window Using the Title Bar 
 

 

 

We can also move the whole window without resizing it using the title bar. 

1. Place your mouse pointer on the title bar area (aim for somewhere around the middle). 
2. Click and hold and drag your mouse to move the window left, right, up, or down. 
3. Experiment until you feel comfortable. 

 

  

 

Edges for 
resizing 

Min/Max/Close 
Title Bar 
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Exercise 4: Switching Between Multiple Windows  
 
We should have a Chrome window open. If not, go ahead and open Chrome.  
Let’s open Microsoft Word in a second Window by using a desktop shortcut. 

 
 
To do this we will need to be able to see the desktop  

 
 
1. If you cannot see the Microsoft Word shortcut, either resize the Chrome window or move 

the Chrome window to the side. Can you remember how to do this? 
2. Double click on the Word shortcut to open a Word window.  

 
Q: Why did we have to click twice this time when we used the desktop shortcut? 
A: When you double click you are doing 2 things: the first click “selects” the item and the 
second click is the action – in this case “open”. 
 

3. You should have two windows open. To switch between them just click once in each 
window. Try it out. 
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4. Also use the moving, resizing, minimize and restore techniques you’ve already tried. Get 
some practice. 

5. Notice the taskbar. What do you see? 
6. Try clicking on each taskbar icon for Word and Chrome. What happens? 

 

 
 
 
TIP: You can also control your windows using the taskbar icons!  
You can minimize and restore by clicking on an icon for an open window. This is a “toggle” 
function: click once to minimize, click again to restore, repeat as needed. 
 
TIP: You can also hover your mouse pointer over an icon to get a small pop-up preview 
window. You can click on this to restore the full window or even click on the X to close it. 

 
Take a Stretch Break! 

 

It’s important to take breaks when using a computer for any length of time. 

Take a minute now - shake out your hands and arms, and stand up if you are able.  

Re-focus your eyes away from the monitor to a place about 20 feet away. 
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Exercise 5: Files – Making and Saving a Word File 
 
For Exercises 5 and 6 we are going to make and save a couple of files so we can see where they 
are saved and how to work with saved files. Let’s start with a Word document. 

 
1. Open Word if it is not already open. Do you remember how to open this application? 
2. Click on Blank Document 
3. You should see a cursor flashing in the top left corner of the page – this is your prompt to 

start typing. Notice how the cursor moves as you type. 
4. Type the word test 
5. Now we will save this document (or file). Click on the File Tab in the top left of the window. 
 

  
 
6. The File menu has a number of options including Save, Save As, Print.  
7. Click on Save. 
8. You will now be prompted to tell the computer where you want to save your file. Click on 

Browse. 
9. Here in the library, you may save to the Public (P:) drive, at home you would save to your 

Documents folder. 
  

TIP: If you use a computer at home, it’s a good practice to use the folders (or Libraries) already 
set-up for you. Notice there are folders for Documents, Music, Pictures, Videos.  

Here at the library, only the Public (P:) drive is available for your use.  
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Why? Because the contents of this drive are deleted every time you log off the computer, 
protecting your privacy. 

 
9. Now that we know where to save our file, we need to name it. You can use whatever 

name you want – I will call mine test. Notice how Word automatically gives it a file type: 
.docx. Now my file is called test.docx 

10. Click on Save. Notice: our document is still open. Close it. 
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Exercise 6: Files – Making and Saving an Excel File 
 
Let’s get some practice making a file using a different application or software: Excel 

 

1. Open Excel using the desktop shortcut. Do you remember how?  
2. When Excel opens, click on Blank Workbook. You should see a square in the top left corner 

of the page outlined in green – this is your prompt to start typing.  
3. Type the words test budget 

 

 
4. Now we will save this document: Click on the File Tab in the top left of the window. 
5. Notice: this is the same method we just used for Word and the menu looks very much like 

the one for Word! Click on Save and name the file test budget.xlsx 
 

TIP: After you Save a file you can continue to update it and save it under the original name. If 
you want to make new, or multiple, versions of a file, use Save As. 

TIP: Use meaningful file names when you save.  You can use letters, numbers and spaces. Up 
to 255 characters. Many special characters are not valid however. If you get an error message it 
might be due to this restriction. 

TOP TIP: Pay attention to commonly occurring software tools and commands.  Software 
designers want to make their products as useable as possible. 
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Exercise 7: Files – Finding and Opening using Windows File Explorer 
 

Now that we’ve made a couple of files how do we find them? We already know that Windows 
uses a real office as a metaphor for its design. So how do we find the “filing cabinet” where 
our files are stored? Windows File Explorer is the software we’ll use to see where our files are 
stored and how they are organized in folders. 

Let’s try this out. 

 
 
1. Open Windows File Explorer by clicking once on the folder icon in the taskbar or double-

clicking on the desktop icon. 
2. This window has two sections. Click on the folders on the left side and you will see the 

content of that folder in the right side. Click and explore. 
3. When you click on the Public (P:) drive you should see your 2 files. What other 

information can you see? 
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Exercise 8: Files – Organizing 
 
Create a Folder and Move a File 
 

Remember, we compared a computer filing system to filing cabinet? In real life we would 
organize our files into folders, the same is true here on the computer.  

 

 

Let’s make a folder and then move our files into the folder. 

1. Click on the Home tab, then New Folder in our Windows File Explorer 
2. You will see a new folder in the list, the name is highlighted in blue, which means you can 

start typing right over top. Type in the folder name Budget Files. 
3. Let’s move a file in to the Budget Folder. There are many ways to do this. One of the simplest 

is to use the mouse and drag the file into the folder. 
4. Use your mouse: click and hold on the Excel file name test budget then drag the file 

onto the Budget folder and let go. 
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5. As you drag the file both the file and the folder will be highlighted, you will get a pop up 
label “Move to Budget” 

6. Practice with the other files. 
7. Open the Budget folder. You should see the files you moved 
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The Logic of File Structures 
Windows File Explorer is your virtual filing cabinet. As in the real world, you may have a number 
of drawers in your cabinet and those drawers may have a number of categories of folders and 
each category may contain a number of files. They are arranged in a hierarchy. 

Your computer uses a similar method and hierarchy. Here’s an example to illustrate the idea: 

 
  
I have a Computer, with a storage drive labelled P:, in which I have a folder for Budget Files 
containing a test budget Excel file. Or, working backwards, my test budget Excel file is stored in 
my Budget Files folder, on the P: drive, on this computer. 

In real life I might have a filing cabinet in which I have a drawer for Household Finances with a 
file folder for Income Tax returns, in which I can find my 2018 tax return. 

You can arrange your files and folders (and sub-folders) using any system the makes sense and 
works for you. 

  

TIP: If you have a computer at home your drives are already set-up and they include the most 
commonly used folders (such as Documents, Pictures, Music, etc.,).  

You can use these high level categories, then add folders to organize your files within each 
category.  
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Delete a File 
1. With your budget folder open, select any file by clicking on it once 
2. To delete: press the delete key on your keyboard 
3. You should get a message asking you to confirm your deletion. Click on Yes to delete 

 

 

 

TIP - Recycle Bin: At the library, if you delete a file on a TPL computer it is permanently 
deleted.  

At home, you can undelete files from the Recycle Bin.  
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WRAP UP: Common features to keep you fearless! 
 
It takes time to learn a new skill. Computer applications are no different. But with time and 
practice it gets easier. It’s also fun to learn something new!  

At first you might be concerned about making a “mistake” but try not to be. You can’t really 
“break” anything! You can always make a copy (or a backup) of a file before editing or changing 
it.  

And while there is a learning curve it’s good to know that there are many common functions 
across different programs. It may surprise you to know that most functions are found in the 
same menus in different software.  

Understanding the similarities across different programs can really help you use and learn a 
new one.  

 

Today you learned more about the Windows 10 operating system and how 
 
 the Desktop is arranged 
 you can use the Taskbar to see what software is running or which windows are minimized 
 to re-size and re-position windows 
 to use File Explorer to locate and arrange files you have made and saved 
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WHERE TO LEARN MORE 
 
Free Online 
GCF Learn:  

Getting Started with Windows 10: https://edu.gcfglobal.org/en/windows10  
Windows Basics: https://edu.gcfglobal.org/en/windowsbasics/ 
Computer Basics: https://edu.gcfglobal.org/en/computerbasics/ 
Basic Computer Skills: https://edu.gcfglobal.org/en/basic-computer-skills/ 
What is a Computer: https://edu.gcfglobal.org/en/computerbasics/what-is-a-computer/1/  
 

LinkedIn Learning 

Lynda is a collection of high-quality instructional video accessible for free via the library’s 
website:  tpl.ca. You must be connected to the Internet and have a valid library card to use this 
collection. 

 

1. On the TPL home page, click on the eLearning portal or tpl.ca/elearning  
2. Click on the link for LinkedIn Learning and select Access Online, then Get Started.  
3. Type your library card number and PIN in the boxes, Sign In and click the Continue button.  
4. Use the top search box to find video classes, such as:  
 

Computer Literacy for Windows 10 - (1h 44m) 
https://www.linkedin.com/learning/computer-literacy-for-windows-10-2021/get-up-to-speed-
with-your-windows-computer  
 
Windows 10 Essential Training – (3h 25m) 
https://www.linkedin.com/learning/windows-10-essential-training-8638626/learn-windows-10  
 
Next Steps 
We hope you enjoyed this series of classes: Computers for Beginners. Remember to practice! 
Take the class again if you want to. Or, if you want a new challenge, take one of the MS Office 
classes on Word, Excel or PowerPoint. Thank-you for attending! 

https://edu.gcfglobal.org/en/windows10
https://edu.gcfglobal.org/en/windowsbasics/
https://edu.gcfglobal.org/en/computerbasics/
https://edu.gcfglobal.org/en/basic-computer-skills/
https://edu.gcfglobal.org/en/computerbasics/what-is-a-computer/1/
https://www.linkedin.com/learning/computer-literacy-for-windows-10-2021/get-up-to-speed-with-your-windows-computer
https://www.linkedin.com/learning/computer-literacy-for-windows-10-2021/get-up-to-speed-with-your-windows-computer
https://www.linkedin.com/learning/windows-10-essential-training-8638626/learn-windows-10
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Practice Exercise 1: Sort files using headers in Details View 
 

1. Look at your files in Details View. What do you see? 
2. Notice you have columns for Name, Date Modified, Type, Size 
3. Click on the column header “Name”. What happens? Click it again. What happens? 
4. Click on the other headers and see what happens.  
5. How would this tool be useful if you had a lot of files? 

 

 
Details View: 

 
Resizing columns 
1. You can widen a column to see more information. Place your mouse pointer on the right 

edge of the column until you see the 2-headed arrow, then click, hold and drag. 
 

 
 
Opening a File: 
 
1. Double click anywhere in the row, in Details View 
2. Experiment with opening and closing files. 
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Practice Exercise 2: Files – Save As 
We know how to save a document. Let’s get some more practice seeing how saving works. 

1. Open the file test.docx.   
2. Let’s add another line of text – I will just type in test again. 

 

 
3. Let’s save this new version of the file now that we have changed it by adding text. Do you 

remember how? 
4. Click on File, then click on Save. What happened this time? 
5. Because we already gave this file a name and a place to be saved, we don’t need to go 

through the all the same steps again. This file with its latest changes is now test.docx. 
6. Let’s add another line of text. Type in anything you like - I will type in my name  
7. This time, to save our file click on File and then Save As 
8. Now we do get the option to give the file a name – I will name my file test2.docx 
9. Close Word by clicking on the X in the top right corner of the window. 
10. Open each of your 2 documents to see the differences. 

 

 

TIP: Why use Save As? What if I have a form and I want to keep a blank master copy, I could 
save it as the master, then use Save As to make a 2nd copy to fill in. Or perhaps I am writing a 
book and want to keep separate copies of each draft so I can keep them for future edits. 
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Practice Exercise 3: Files – Using Undo/Redo 
 
1. Open Word again. Do you remember how to open this application? 
2. This time Type in your address 

 
TIP: to move your cursor to the next line, press Enter once on your keyboard 

 

  
 

Let’s imagine we made a mistake. We can use the Backspace key on the keyboard but there is 
another useful tool that many applications include: Undo (and Redo) 

3. Try it out! Experiment by clicking on each arrow. Try the back button (Undo) then the 
forward button (Redo) What happened? 

4. When you are done, close the file but do not save. 
 

Tools like Undo and Redo are great to remember. You can use applications without fear of 
making mistakes because you can easily undo them! 


